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2 Foreword

Grüezi, hello, hello,

LibreCAD is an exciting and user-friendly open source CAD program that is ideal for 2D 
drawings and designs. Whether you are an engineer, architect, designer or hobbyist, 
LibreCAD provides you with the key tools and features you need to create professional 
drawings.

This book or tutorial is designed to give you a comprehensive overview of LibreCAD and 
help you get the most out of this program. We will cover the basics of LibreCAD, such as 
the user interface, tools and functions, creating drawings and working with blocks and 
libraries. We will also cover more advanced topics such as panel projection, creating 
hatches and using variables.

This book is aimed at beginners and advanced users alike. If you are new to the world of 
CAD drawings, we will show you step by step how to create your first drawings and 
master the basics of LibreCAD. If you already have experience with LibreCAD or other 
CAD programs, we will help you improve your skills and learn new features and 
techniques.

We have designed this book to be easy to read and understand, with many examples and 
illustrations that will help you visualize the concepts and techniques. We have also made 
sure that this book has been updated with the latest version of LibreCAD so that you can 
learn about the latest features and tools.

We hope this book will help you improve your skills in LibreCAD and increase your 
creativity and productivity. Whether you are a professional designer or a hobbyist, we 
are confident that you will find useful information and techniques in this book that will 
help you achieve your goals.

Enjoy reading and learning!
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2.1 One request...
We have endeavored to make this book as error-free as possible. However, if you notice 
any typographical errors or inaccuracies, we would be very grateful if you would report 
them to us. As this book is written by users for users, we are always striving to improve 
and update it to ensure that it is as useful and informative as possible. We hope that you 
will find this book a helpful resource for your work with LibreCAD and wish you every 
success with your projects!

This LibreCAD book is a living project and you will find on one of the last pages an e-mail 
address where you can send us improvements at any time.

"Merci vielmal!"
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LM = left mouse button
RM = right mouse button

3 First things first!
The following points are advantageous if you already know them:

[Ctrl] the control key corresponds to [Ctrl] on a German keyboard.

RM-click opens a menu with the most recently used functions.

Ctrl + Z = Undo / Ctrl + Y = Redo.
Ctrl + C = Copy with reference point / Ctrl + V = Paste with target point.

Space bar activates the command line.

Polar coordinate input in the command line: @30<45 

Angular input Horizontal is 0° counterclockwise RM or 

Esc key cancels a function.

Zoom with mouse wheel / Pan-Zoom Hold down the mouse wheel.

Objects are elements are entities
See chapter 5 Entities, objects and elements

Calculator on/off: cal → Enter (command line) A 

drawing template is the same as a template.
See chapter 18 Saving settings as a template

Standard parts are blocks, symbols are blocks → are imported files.
See chapter 42 Using blocks and 44.2 Central standard parts library

Standard parts path: for library browser see chapter 44.2 Central standard parts library

For functions that require a mass input, such as a parallel line, the distance can be entered 
at the top of the status line or directly in the command line.
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4 What is a CAD program?
A 2D CAD (Computer-Aided Design) program is software that allows users to create, 
modify and save two-dimensional technical drawings, sketches, plans and diagrams. This 
type of software is often used in various industries, such as mechanical engineering, 
architecture, civil engineering, electrical engineering and many other areas where 
precise technical drawings are required.

2D CAD programs offer a variety of functions and tools to create and edit geometric 
shapes, lines, circles, arcs, curves and other elements. Users can combine these elements 
to create complex drawings that are true to scale and accurate. The most important 
functions of 2D CAD programs usually include

• Drawing tools: lines, circles, arcs, curves, polylines, splines, etc.

• Editing tools: move, rotate, scale, mirror, trim, extend, etc.

• Dimensioning and labeling tools: linear, radial, angular, diameter 
dimensions, texts, tolerances, etc.

• Layer management: Organize drawing elements in different layers for better 
control and visibility

• Hatches and patterns: Adding hatches and patterns for different materials and 
surfaces

• Import and export functions: Support of various file formats such as DWG, 
DXF, PDF, SVG etc.

Some examples of 2D CAD programs are AutoCAD, AutoCAD LT, DraftSight, TurboCAD, 
LibreCAD* and many others. These programs may be available as standalone software or 
as part of a more comprehensive CAD suite that also includes 3D modeling and other 
advanced features.

* Open source and free of charge!



16

Chapter 5 Entities, objects and 
e l e m e n t s  

5 Entities, objects and elements
In 2D CAD programs, different terms are used to describe the basic building blocks of 
drawings. Although these terms are often used interchangeably, there are subtle 
differences between them:

Entities are the most basic building blocks of a CAD drawing. They represent geometric 
shapes such as lines, arcs, circles, polygons and text. Entities have properties such as color, 
thickness and material.

Objects are groups of entities that can be combined and treated as a single unit. They can 
be used to create complex shapes or assemblies. Objects have properties such as name, 
description and layer.

Elements are a more abstract term for entities and objects. They can refer to individual 
entities, groups of entities or even entire drawings. Elements are often used in 
commands and functions of CAD programs.

To summarize:

• Entities are the basic geometric shapes.
• Objects are groups of entities that can be treated as a unit.
• Elements are a general term for entities and objects.

Here is an example to illustrate the differences:

Imagine you are drawing a house in a CAD program. The walls, the roof, the windows and 
the doors are all entities. You can group these entities into a "house" object. The house 
itself can then be used as an element in a parts list or other report.

Other differences:

• Entities always have a unique ID, whereas objects and elements do not 
necessarily have to.

• Entities can only belong to one object, while objects and elements can belong 
to several objects or groups.

• Entities are usually saved on the drawing level, while objects and elements can 
be saved in separate data structures.

The exact definitions and relationships between entities, objects and elements may vary 
depending on the CAD program. However, it is important to understand the basic 
differences in order to use CAD programs effectively.
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6 What is LibreCAD?
LibreCAD is an open source CAD program that supports 2D drawings and designs. It is a 
powerful yet user-friendly tool that is available for various platforms such as Windows, 
MacOS and Linux. In this tutorial, we will cover the basics of LibreCAD's operating 
philosophy to help you get started with the software.

Main features:

■ Drawing tools: lines, arcs, circles, polygons, splines, dimensions, labels and 
more

■ Modification tools: move, copy, rotate, scale, mirror, trim, extend and more

■ Snap functions: Object snap, end point snap, center point snap, intersection snap 
and more

■ Layers: Organize your drawing in layers
■ Blocks: Create reusable symbols and groups
■ Layouts: Create multiple views of your drawing
■ DXF/DWG support: Import and export of DXF and DWG files (AutoCAD 

format)

■ PDF and SVG export: Export your drawings to PDF and SVG files
■ Multilingual: Over 30 languages available
■ License: GPLv2 (Free Software)

6.1 Download and links

Website: https://librecad.org/

Documentation: https://dokuwiki.librecad.org/ 

Wiki: https://wiki.librecad.org/index.php 

Forum: https://forum.librecad.org/

https://forum.librecad.org/
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6.2 LibreCAD is well suited for
• Technical drawings: Creating floor plans, sections, views and details

• Mechanical design: designing machines and components

• Electronics: Creating circuit board layouts

• Architecture: Designing buildings and spaces

• Landscaping: Creating garden plans

• Hobby and handicraft work: Creating designs for furniture, decoration and more

LibreCAD is an easy-to-use yet powerful 2D CAD software that is ideal for private and 
professional use.

6.3 The history of LibreCAD
LibreCAD is a free 2D CAD software that was created in 2011 from a fork of the open 
source software QCad Community Edition. The original QCad software was developed 
by RibbonSoft and was licensed under the GPLv3 license.

6.4 The most important milestones in the development of LibreCAD
2011: Foundation of the LibreCAD project
2013: Release of the first stable version 1.0 2015: 
Introduction of support for the DWG format
2017: Release of version 2.0 with numerous new functions 2020: Release 
of version 2.1 with further improvements 2023: Release of version 2.2 
with support for 3D objects

6.5 LibreCAD today
LibreCAD is an active open source community with a constantly growing number of users 
and developers. The software is constantly being developed and improved. It is a free 
and open-source alternative to commercial 2D CAD programs such as AutoCAD and is 
ideal for private and professional use.

6.6 Is LibreCAD the right choice for you?
It depends on your individual needs and requirements. If you are looking for free, open 
source and cross-platform CAD software for creating two-dimensional drawings, 
LibreCAD is a good option and an excellent choice for users looking for CAD software 
without copy protection. LibreCAD is a completely free and open source program 
licensed under the GNU General Public License (GPL) v3.0. This means that you can 
download, use, modify and redistribute it freely.
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7 DXF and DWG file format

DXF and DWG are the most important file formats in the 2D CAD sector. Both are vector 
graphic file formats. Vector graphics retain the same image quality at any scale and are 
therefore ideal for design purposes. In addition, the individual elements that make up a 
vector image can be easily edited and elements can be added and removed.

DXF (Data eXchange Format) was developed as a tool for exchanging drawings between 
different CAD and vector-based programs. It saves 2D vector images and can be used by 
almost all CAD programs as well as CNC and GIS (Geographic Information System) 
software.

Each element of the drawing is written in plain text or ASCII format, which contains all 
alphanumeric characters. Due to their file specifications, complex DXF drawings can be 
very large - from several to hundreds of megabytes. If such a document is to be 
transferred, it must either be split or compressed.

DWG (for Drawing) is a proprietary format and is only included in LibreCAD in the beta 
stage. If you need to import DWG files, we recommend the following DWG 
viewer/converter from VariCAD in chapter: 57 Useful links
This costs only USD 25 and is of excellent quality. It converts all DWG and DXF versions 
so that they can usually be read into LibreCAD without errors.
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8 Basics
In order to use LibreCAD effectively, some concepts need to be understood. While a 
simple drawing or sketch can be created after the initial setup, for more complex 
drawings it is important to consider the elements of a complete drawing. This section 
provides an introduction to some of the concepts required to create a drawing, but is by 
no means exhaustive. The remainder contains a description of the tools used to 
configure, create and modify drawings. Further general examples and instructions can be 
found in the User Manual section.

LibreCAD supports two drawing perspectives: orthogonal and isometric projections. The 
orthogonal projection is the standard perspective for creating two-dimensional (2D) 
drawings. An isometric projection allows LibreCAD to display a three-dimensional object in 
two dimensions, sometimes referred to as "2.5D". Both projections use coordinates to 
localize drawing elements.

8.1 Coordinate systems
In 2D CAD programs (Computer Aided Design), geometric shapes such as points, lines, 
circles, arcs, etc. are created and edited on a two-dimensional plane. The position of 
these elements on the drawing plane is defined by a coordinate system consisting of an x-
axis (horizontal) and a y-axis (vertical). Each point on this plane therefore has a unique 
address, which is represented by an ordered pair of coordinates (x, y).

Coordinate input is a method of precisely determining the position of geometric 
elements. Instead of manually drawing elements with the mouse, users can enter the 
exact coordinates where the element should be placed. This leads to greater accuracy 
and makes it possible to create complex geometric shapes.

To use coordinate input in a 2D CAD program, users must usually first select the desired 
geometric element (e.g. a line or a circle). They can then enter the coordinates for the 
start point and the end point (or the center point and the radius in the case of a circle).
This can be done either via a prompt in the command line of the program or by filling in 
fields in a dialog box.
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It is important to adhere to the correct coordinate sequence (x, y) and to enter the 
coordinates in the unit of measurement supported by the program (e.g. millimetres, 
inches). Once the coordinates have been entered, the geometric element is 
automatically placed at the specified position on the drawing plane.

In summary, coordinate input in 2D CAD programs enables precise positioning of 
geometric elements on the drawing plane by entering coordinate values.

Understanding coordinate systems and the way coordinates work in LibreCAD is necessary 
to create accurate drawings. Points are used to describe an aspect of an object (e.g. the 
end of a line, the center of a circle, etc.) and can be accurately placed using coordinates.

There are two coordinate systems used in LibreCAD to place a point in a drawing. A point 

can be placed by specifying a coordinate system:

• a horizontal distance and a vertical distance from a reference point (Cartesian) or

• an angle and a distance from a reference point (polar).

8.2 Angle
Angles are also used in LibreCAD. While horizontal or vertical distances are measured in 
the specified unit, angles in LibreCAD are always measured in degrees, starting at 0 
degrees horizontally to the right of the origin or at



22

Chapter 8 Basics

the 3 o'clock position. Angles that are 
entered as a positive value are 
measured counterclockwise. Angles that 
are entered as a negative value are 
measured clockwise.

When using absolute coordinates, 
whether Cartesian or polar, the points are 
entered in direct relation to the origin 
(0,0). To do this in LibreCAD, enter the 
desired point,
e.g. 100.75 or 100<45, as shown in the 
two images above.

The next point can also be placed relative to the previously placed point. The last point 
that was set when an object was created becomes a temporary reference for the next 
point. The newly set temporary reference point is the "Relative zero point" and the next 
coordinates can be entered relative to this point. To define the next point relative (often 
referred to as incremental) to the relative zero point, either Cartesian or polar, prefix the 
coordinates with "@". Points without the prefix @ are always interpreted as absolute 
coordinates.

Cartesian coordinates are used to set a point 75 units to the right and 65 units above the 
previous point, take @75,65. In the example shown, the previous point was set 25 units 
horizontally and 35 units vertically (25,35) from the origin (0,0). The next point can be set 
@75.65 from the relative zero point at 25.35, resulting in a point at 100.100 absolute 
(100 units horizontally and 100 vertically from the origin).

Relative coordinates or incremental coordinates can also be entered using the "x..y" 
format. This format corresponds to placing the "@" symbol in front of the coordinates.
For example, if you enter the coordinates "75..65", this corresponds to "@75,65".

Please familiarize yourself with the possibility of entering Cartesian and polar 
coordinates. This will be used from time to time throughout the book.
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Question: What do these following inputs generate when you use the function:

Lines → 2-point takes? Command line: 0.0 ↵ 50,0 ↵ @50<120 ↵ 0,0 ↵

Figure 1: Absolute and relative Cartesian coordinates

Figure 2: Absolute Cartesian and relative polar coordinates

Polar coordinates: To place a point 100 mm and 45 degrees from the last drawn point at 
25.35 (absolute Cartesian), use "@100<45" (relative Polar).
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8.2.1 Conversion between Cartesian and polar

Conversion: It is possible to convert between Cartesian and polar coordinates. The 
conversion from polar coordinates to Cartesian coordinates is carried out using the 
following formulas:

x = r * cos(θ) 
y = r * sin(θ)

Cartesian coordinates are converted to polar coordinates using the following formulas:

r = √(x² + y²)

θ = arctan(y/x)

To summarize, Cartesian and polar coordinates are two different ways of representing 
the position of a point in a two-dimensional plane. Cartesian coordinates use a distance 
from two axes, while polar coordinates use a distance and an angle from the pole and the 
polar axis. The choice of coordinate system depends on the specific application.

8.3 Repetition: Absolute and relative coordinates
Absolute coordinates: Absolute coordinates refer to a fixed coordinate system in which 
each point in the plane is represented by a unique pair of coordinates (x, y). The origin of 
the coordinate system is at a fixed position and all distances are measured from this 
origin.

Relative coordinates: Relative coordinates or incremental coordinates refer to the current 
position of the cursor or the last defined point. In this system, the position of a point is 
specified by the distance and direction from the current position. For example, if a point 
was defined at (10, 10) and the next point should be 5 units to the right and 3 units 
upwards, relative coordinates can be used to define the new point at (15, 13).
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Differences:

1. Reference point: The main difference between absolute and relative coordinates 
is that absolute coordinates have a fixed reference point, while relative 
coordinates are based on the current position.

2. Accuracy: Absolute coordinates are generally more accurate than relative 
coordinates, as they are based on a fixed coordinate system and do not depend 
on the current position.

3. Flexibility: Relative coordinates are more flexible than absolute coordinates 
because they allow you to specify distances and directions from the current 
position instead of specifying the exact position of each point.

4. Application: Absolute coordinates are often used in applications where high 
accuracy is required, such as in mechanical engineering or architecture. Relative 
coordinates, on the other hand, are often used in applications where flexibility is 
more important than accuracy, e.g. in graphic design or image processing.

To summarize, absolute and relative coordinates are two different ways of representing 
the position of a point in a plane. Absolute coordinates refer to a fixed coordinate 
system, while relative coordinates are based on the current position.

8.4 Coordinate input

In LibreCAD, coordinates can be entered in various formats, depending on the 
user's requirements and the specific drawing. Basically, LibreCAD supports the 
input of Cartesian coordinates, polar coordinates and relative coordinates.

Cartesian: Cartesian coordinates can be entered in LibreCAD in the following 
form:

• Absolute: x,y, where x and y are the coordinate 
values. For example: 10,20

• Relative: @dx,dy, where dx and dy are the displacement values from the current
position are. For example: @10,20

Polar: Polar coordinates can be entered in LibreCAD in the following form:
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• Absolute: r<angle, where r is the distance from the coordinate origin and angle is 
the clockwise angle from the positive part of the x-axis. For example: 5<45

• Relative: @dx<angle, where dx is the displacement value in the direction of the 
angle and wangle is the clockwise angle from the positive part of the x-axis. For 
example: @5<45

It is important to note that in LibreCAD the units for the coordinate values are set to 
millimeters by default. However, users can select other units such as inches, feet, meters, 
etc. by changing the settings for the drawing.

In summary, LibreCAD supports various formats for coordinate input, including Cartesian, 
polar and relative coordinates. Users can select the format that best suits their 
requirements and their specific drawing.

Below are some examples of Cartesian and polar coordinate input in LibreCAD, both 
absolute and relative:

Cartesian coordinates:

• Absolute: To place a point at (5,3), enter "5,3" in the command line.
• Relative: To place a point 5 units to the right and 3 units up from the current 

point, enter "@5,3" in the command line.

Polar coordinates:

• Absolute: To place a point at (3<45) (i.e. 3 units from the origin and 45 degrees 
from the positive x-axis), enter "3<45" in the command line.

• Relative: To place a point 3 units away from the current point and 45 degrees 
clockwise from the positive x-axis, enter "@3<45" in the command line.

Tip: If it is not possible to make the entry in the command line, you can use the
space bar to set the input focus to these.
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8.5 Views side view, elevation, floor plan
In 2D drawings, there are different views to represent an object from different perspectives. The 
most common views are

1. Floor plan (also known as plan view): This view shows the object from above, as if 
you were looking directly at it. It is often used to show the horizontal extent and 
arrangement of the elements of an object.

2. Elevation view (also known as front view): This view shows the object from the 
front, as if you were looking directly at it. It is often used to show the vertical 
extent and shape of the object.

3. Side view (side view or also referred to as profile view): This view shows the object 
from the side. It is used to show the depth and lateral extent of the object. There 
can be a left and a right side view, depending on which side the object is viewed 
from.

Positional 
relationships 
between the 
individual views

DIN EN ISO 5456
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9 Pen assistant
.

As with many other aspects of drawing, the color, thickness and type of a line or circle are 
determined by drawing conventions or general practices. In LibreCAD, the three attributes 
are summarized under the term "pen":

- Color - LibreCAD has 16 standard colors, but supports the RGB color space (#000000 
to #FFFFFF or 16,777,215 colors). The default color for objects is black.

- Width - The standard line width is 0.00mm. Line widths of up to 2.11mm are 
supported.

- Line type - The default line type is "Continuous" (e.g. solid). Other line types included 
in LibreCAD are "Point", "Stroke", "Split", "Center" and "Border".

The pen attributes can be defined for an individual element (using the "Properties" tool), 
for a group of selected elements (using the "Attribute" tool) or for a layer.

Note: As with objects, pens can also be applied to layers. For more information on 
setting the attributes of a layer, see Dock of the layer list or Layer list.

Perhaps someone can contribute more to the pen assistant?
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10 Color

The color for an element can be selected via the "Color" drop-down menu. The drop-
down menu allows you to select the color "By layer", "By block", from the "Custom" 
color picker or quickly select from one of the 16 predefined colors:

If "By layer" is selected, the element is assigned the color that was defined for the layer 
(see above). If the selected color of the layer is subsequently changed, the color of the 
layer is assigned to all objects on the layer.

When editing a block, the color defined for the block is assigned to the added object if 
you select "By block". If the color of the block is subsequently changed, the color of the 
block is assigned to all elements of the block. If you select "Custom", you can choose 
from a palette of 36 colors and shades of grey or from colors defined by the user.

Custom colors are created by clicking the Add button and then selecting the hue and 
value with the color picker tool. Custom colors can be changed by right-clicking on a 
custom color and selecting a new hue and value. Custom colors can also be added.
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10.1 Line widths
The standard line thickness of LibreCAD is 0.00 mm (hairline) and ranges up to 2.11
mm. The range includes lines with ISO standard width. The line widths vary depending 
on the intended use (outlines, hidden lines, sections, etc.) and the size of the drawing; 
thicker lines are used for larger drawings. In addition to the line widths, four further 
options are displayed in the drop-down list:

• Unchanged: Leaves the line width as previously selected.
• By layer: Adopts the line width set in the attributes of the layer.
• After block: Adopts the line width that was used when the block was 

created.

• Default: Resets the line width to the default value (0.00 mm). You can find 
examples of line thicknesses depending on the intended use under General line 
thicknesses in the appendix.

It seems that the representation of line widths in LibreCAD was a problem in the past, 
especially when it came to printing. In previous versions of LibreCAD, there were 
sometimes difficulties in displaying line widths accurately, especially when printing a 
project.

However, like many open source software projects, LibreCAD has an active developer 
community that is constantly working on improvements. It is therefore possible that these 
problems have been fixed in the meantime or that there are workarounds to circumvent 
them.

If you have specific issues with line width rendering in LibreCAD, I would recommend 
checking the latest version and making sure you have the latest updates installed. In many 
cases, a look at the official documentation or the user forum can also be helpful to find 
possible solutions or to get advice from other users who have had similar problems.

Note: Depending on the graphics card and resolution, line widths are sometimes 
displayed too thin or too wide. It is therefore important to test the settings and adjust 
them in 0.05 mm increments if necessary.
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11 Layers

One of the most important functions of LibreCAD is the use of layers. Layers (also 
called layers in other programs) help with the organization of
drawings by allowing the user to place and manage related elements. Traditional manual 
drawing used a similar approach. Layers were often drawn on separate transparent 
sheets. These sheets were then placed on top of each other to create the final drawing.

Whether in engineering, architecture, construction, manufacturing or other fields, layers 
have been used to represent various aspects of the drawing. Layers can be added to show 
centerlines or dimensions on engineering or manufacturing drawings, or to show various 
building systems on architectural drawings, such as exterior walls, partitions, electrical, 
HVAC, grid lines, etc. While a layer can contain multiple objects, each object in a drawing 
can only be associated with a single layer. Typically, objects with common functions or 
attributes are placed on the same layer. For example, all walls in a floor plan drawing 
would be placed on a layer named "Walls".

Layers have the additional advantage that all pen attributes can be assigned to a layer. 
Each element on this layer takes on the attributes that have been assigned to this layer. 
However, the attributes assigned by the layer can be overwritten for elements if required. 
In the example above, a line thickness can be applied to all elements on the "Walls" layer 
by changing the "Layer settings" for this layer.

Layers are an indispensable element in the CAD design process. Layers in DXF and DWG 

files are fully compatible with other CAD programs.
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11.1 Create level
Layers are usually created to store elements with 
common attributes. Creating a layer is simple:

• Click on the Add layer icon

• Enter a layer name
• Optionally set the color, width and line 

type for the layer

• Click on Ok.

11.1.1 Design level

A design level is used to record geometric auxiliary 
construction lines:

• A draft level does not appear on the printout.

• All lines of a design level are unlimited in length.
You can switch between draft and normal mode in three ways:

1. Click on the checkbox when creating or changing a layer
Design layer in the Layer settings dialog box.

2. Right-click on a named layer in the layer list and select Switch 
construction layer.

3. Click on the "#" symbol in the layer list →
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12 Functions Brief overview
LibreCAD offers a wide range of functions that make it a powerful yet user-friendly tool 
for 2D CAD drawings:

12.1 Vector-based drawings
LibreCAD works with vector graphics consisting of geometric shapes such as lines, 
circles, arcs and curves. This makes it possible to create precise and scalable drawings 
that can be printed or exported in various sizes and resolutions without any loss of 
quality.

12.2 Intuitive user interface
The LibreCAD user interface is simple and clearly laid out, with a menu bar, toolbars, a 
drawing area and a status bar. This makes it easy to get started with the program, even 
for beginners in the CAD field.

12.3 Various drawing tools
LibreCAD offers an extensive range of drawing tools with which you can create lines, 
circles, ellipses, polygons, splines and other geometric shapes.
You also have commands for copying, moving, rotating, mirroring and scaling objects.

12.4 Layers
LibreCAD supports layers to help you organize and manage your drawing. Layers can be 
shown and hidden, locked and renamed to simplify the drawing process and improve 
clarity.

12.5 Catch functions, snapping (snap-in functions)
LibreCAD has various snapping functions that help you to create precise drawings. These 
include end point, center point and intersection as well as a grid and orthogonal 
drawing.

12.6 Support for various file formats
LibreCAD uses the DXF format (Drawing Exchange Format) by default, which is 
compatible with other CAD programs. You can also export your drawings in other 
formats, such as SVG, PDF or PNG.

12.7 Customizable user interface
LibreCAD allows you to customize the user interface to your needs by adding, removing 
or rearranging toolbars and defining keyboard shortcuts for frequently used commands.
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13 Installation
Download the appropriate setup file for your operating system from:

https://www.librecad.org

Execute the installation file:

Settings:

Default Unit: Millimeter

GUI Language: German German

Command Language: English

Note: In some Windows configurations, the Command Language: English is not set to English 
but to German.

The German commands are described in Chapter 22 Drawing tools and command line.

http://www.librecad.org/
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14 Reset LibreCAD

To ensure that LibreCAD works optimally with this book, we recommend that you reset 
the software to its default values if you have already made changes or adjustments. To 
do this, you can perform the following steps:

Click on in the menu:

Options -> Application settings -> Tab: Standards

Layout: Resets the layout of the application window to the default configuration.

All: Resets the application to the default configuration. Window layout, color settings, user-
defined menus and toolbars, etc. are all reset. The "Welcome" dialog box is displayed the next 
time the application is started.

It is important to note that the "Reset settings" function only affects the settings and 
adjustments of the program itself and has no effect on the drawings or files created by 
the user.

In summary, the "Reset settings" function in LibreCAD allows the user to restore the program's 
default settings by deleting all user-defined settings and customizations.

This is very useful if the user has made changes that they want to undo or if 
they want to reset the program to the original default settings.

After you have completed these steps, LibreCAD will be reset to its default values and should 
work optimally with this book.
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15 User interface Quick overview
The LibreCAD user interface is clearly laid out and offers quick access to the most 
important functions.

LibreCAD user interface when reinstalling or resetting all settings.

(1) CAD functions.
(2) Command line, activate with [Ctrl+M] or [Ctrl+M].
(3) Layer list (Layer) Show, hide, line types.
(4) Switch between library browser, block list, layer list.
(5) Grid status, dynamic background grid. *
(6) Snap functions (especially the grid snap is well looked at in the book!).
(7) See chapter 15.1 Coordinate display.
(8) Relative coordinates in relation to the last point clicked.
(9) Action for the left mouse button (LM) → Section 15.2 Next action with the mouse
(10) Action for the right mouse button (RM) (usually canceling a function).
(11) Upper status bar with entries corresponding to the function.
(12) ZERO POINT of the drawing.
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* The dynamic background grid in LibreCAD is a tool that helps you to create precise 
drawings. It is a grid of points that is displayed in the background of your drawing and 
serves as a reference point for positioning objects exactly.

Adjustable spacing: You can adjust the spacing between the grid points or lines to adapt 
the grid to your specific requirements. This can be done either globally for the entire 
drawing or locally for a specific area.

Dynamic display: The grid is displayed dynamically, i.e. it adjusts automatically when you 
zoom in or out in the drawing. This allows you to use the grid at different scales without 
having to adjust it manually each time.

15.1 Coordinate display

Displays the absolute coordinates (left) and the relative coordinates (right) of the 
crosshairs/cursor. The Cartesian coordinates are displayed at the top and the polar 
coordinates at the bottom. For more information on the type of coordinates, see 
Coordinate systems.

15.2 Next action with the mouse

Displays a prompt for the next action required for the current command, e.g. 
"Specify next point", "Specify center", etc.
Prompts to the left of the mouse symbol represent actions with the left mouse button 
(LM), those to the right represent actions with the right mouse button (RM).
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Independence from the drawing: The dynamic background grid is not part of the actual 
drawing, but is only displayed as a visual cue. This means that it is not printed or exported 
and does not need to be shared with other users who may be editing the drawing.
The dynamic background grid in LibreCAD is a useful tool to improve the accuracy and 
precision of your drawings and make the drawing process easier overall.

15.3 Zoom in, zoom out and pan-zoom
In LibreCAD you can enlarge, reduce and move the view of your drawing using the zoom 
and pan-zoom functions.

Zoom: The zoom function allows you to enlarge or reduce a specific area of your drawing. 
Use the mouse wheel to zoom in and out. To zoom in or out on a specific area, turn the 
mouse wheel. The zoom is cursor-centric.

Pan-zoom: The pan-zoom function allows you to move the view of your drawing by holding 
down the mouse wheel and moving the mouse.

You can also combine the zoom and pan-zoom functions to quickly and easily navigate 
through your drawing. For example, you can zoom out to get an overview of the entire 
drawing and then use the pan-zoom function to navigate to a specific area that you want 
to take a closer look at. You can then zoom back in to examine the details of that area.

The zoom and pan functions can also be called up manually in the menu bar:

Auto zoom is a frequently used function for large drawings:
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With this function, all drawing objects are optimally 
zoomed in on the screen...

If a drawing is displayed very small, simply click on the 
Autozoom function:

"Zoom window" and "Last view" are two other useful functions in a CAD program that 
can help to control and optimize the view of the drawing.

With the "Zoom window" function, you can enlarge a specific area of the drawing by dragging a 
window around the desired area.

The "Last view" function allows you to quickly and easily return to the previous view of 
the drawing.

As a rule, however, most zoom functions are carried out directly with the mouse.
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16 Basic settings
The following basic settings are also important for progressing through the 
book and are well suited for the mechanical area.

16.1 Program settings
The following settings are made in the Appearance tab via Options -> Application settings:

The background color is usually white or black.

A white background is used in the book because it is more pleasant to read on a sheet of 
paper. In reality, the screen is often drawn against a black background.
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In the Standards tab

16.2 Drawing settings
Via Options -> Drawing settings

16.2.1 Register: Units and decimal places

When it comes to the accuracy of lengths, three to four decimal places are OK...

Main unit: Millimeter

Accuracy: 0.0000
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16.2.2 Register: Dimensions

The dimensioning is slightly too large in its original state. We adjust this by a factor of 1 to
1.25 instead of 2.5.

This is still easy to read and takes up less space on the sheet of paper.

Setting the decimal places for linear dimensioning:

Linear precision: 0.0000
Linear zeros: Delete right

Decimal separator: "."
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Setting the decimal places for angle dimensioning:

Angle precision: 0.0000
Angle zeros: delete right

Accept with OK.

The setting "Delete zeros to the right" for linear and angular dimensioning in 
LibreCAD refers to how many zeros should be displayed after the decimal point. If this 
setting is activated, all leading zeros after the decimal point are deleted.
Decimal point deleted. If it is deactivated, all zeros are displayed after the decimal point 
or the degree sign until the selected accuracy is reached.

For example, if you have a line with a length of 12.5000 mm and the accuracy is 
set to two decimal places:

• If "Delete zeros on right" is activated, the length is displayed as "12.5 mm".

• If "Delete zeros on right" is deactivated, it is displayed as "12.5000 mm".

This setting can be useful to improve the readability of masses and to remove 
unnecessary zeros, especially if there are many masses in a drawing.
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17 Further settings
The most important thing when working with 2D CAD software is the layers. Without a 
layer structure, it is not possible to work with it properly. Layers can also be shown and 
hidden globally and switched on or off for printing on paper.

17.1 Layers and line types
In mechanical engineering, especially in 2D CAD, certain standards for line types, layers 
and colors have been established to ensure a uniform and clear representation of 
drawings. Although standards may vary by company, industry or country, there are some 
generally accepted guidelines. Here are some of the most common:

1. Line types: The line types can vary depending on the element in the 
drawing. Here are some commonly used ones:

• Extracted: For visible edges, outlines and dimensions.
• Dashed: For concealed edges or invisible lines.
• Semicolon: For axes, intersecting lines or center lines.

2. Layers: Layers help to organize the drawing and show or hide certain elements. 
Here are some frequently used ones:

• 0: Standard layer, often for invisible elements or placeholders.
• NOTE: For texts, dimensions and tolerances.
• DIMENSIONING: For dimension lines and auxiliary lines.
• VISIBLE: For visible and concealed geometry.
• INVISIBLE: For concealed lines
• AXES: For center lines and symmetry lines.
• etc...

3. Colors: The following colors are generally used in mechanical engineering.

The color black is used for visible lines, dimensions and text, while white is the 
background.

However, other colors can be used for special purposes, e.g. magenta for 
corrections or revisions. Blue for cosmetic elements such as the thin thread line 
for threaded holes...
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It is important to note that these standards may vary 
depending on the company or project. Therefore, it is 
always advisable to adhere to the specific guidelines 
that apply to your project or organization.

To define the lines, activate the Layer list tab (1) in 
the right-hand panel and click on the [+] button (2).

We agree on the following definitions:

Layer name Color Width Line type

AXES Red 0.13mm Centerline (small)

DIMENSIONING Green 0.13mm continuous

WELFARE LINES Magenta 0.00mm continuous

COSMETIC LINE Blue 0.13mm continuous

HATCHING Black 0.05mm continuous

VISIBLE Black 0.25mm continuous

INVISIBLE Gray 0.18mm dashed (small)

WHITE White (99.9%) 0.00mm continuous

Chart 4: Axes Figure 3: Visible lines
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Figure 5: Invisible edges / lines Diagram 6: Dimensions

Cosmetic lines can be used, for example, when drawing threads or tangential transitions. 
Auxiliary lines are simply auxiliary lines :-)

The color WHITE is a SPECIAL CASE.
To do this, quickly read chapter 41.6 Add WHITE layer to layer list The settings 

should look like this:

These settings guarantee us a consistent CAD image that we can use as a guide in this 
tutorial.
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17.2 Level 0 (zero)
A "level" is the same as a "layer".

The "0" layer has no special meaning. It is the default layer for drawings that are not 
based on a template. In the context of blocks, it is equivalent to "no layer", similar to 
how color "By block" is equivalent to "no specific color" or linetype "By block" is 
equivalent to "no specific linetype".
In general, the "0" layer should only be used when creating blocks and should be the 
only layer in a drawing for a block.

Pay particular attention to the attributes when creating blocks. In addition to the 
specific attributes, the pen attributes (color, width, line type) also include "By layer" and 
"By block".

■ Blocks with certain attributes (e.g. color set to blue, width set to 0.18 mm, etc.) 
retain these attributes when inserted into a drawing. To change one of the 
attributes, the block must be edited.

■ Blocks whose attributes are set to "By layer" adopt the attributes of the layer 
into which they are inserted. The attributes of the block change when the 
attributes of the layer are changed.

■ Blocks whose attributes are set to "By block" initially adopt the attributes assigned 
to the layer. The attributes can be changed using the Attribute tool.

So it's worth mentioning again, because it's important:

According to information from LibreCAD, the layer "0" may generally only be used when 
creating blocks and should be the only layer in a drawing for a block.

Are there people who can say more about this and have a concrete example?
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17.3 Possible problems when printing line widths
The problem with outputting technical drawings with different line widths on different 
printers is that the actual line widths on the paper print may differ from the values 
specified in the drawing. This can lead to inconsistencies and ambiguities in the drawing, 
especially if the line widths are used to differentiate between different elements or to 
represent hierarchies in the drawing.

The causes of these deviations are manifold and can be due to various factors, such as

1. Printer resolution: The resolution of the printer can influence the accuracy of the 
line widths. A lower resolution can result in lines being printed wider or thinner 
than they should be.

2. Printer settings: Various printer settings, such as print quality, color mode or 
paper type, can affect the display of line widths.

3. Drivers and software: The printer drivers and software used can influence the 
line widths by interpreting and processing the drawing data in different ways.

4. Calibration: Incorrect or inaccurate calibration of the printer can lead to 
deviations in the line widths.

To minimize these problems and ensure consistent representation of line widths in 
technical drawings, the following measures can be taken:

1. Use of standardized line widths: The use of standardized line widths, e.g. 
according to DIN 1356 or ISO 128-23, ensures that the line widths in the drawing 
are uniform and clearly defined.

2. Printer calibration: Regular calibration of the printer ensures that it reproduces 
the line widths correctly. Special calibration tools or test prints can be used for 
this.

3. And readjust the line thicknesses in all templates!

By implementing these measures, deviations in the line widths of technical drawings can 
be reduced and consistent presentation on different printers can be guaranteed.
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18 Save settings as a template

So-called templates offer several advantages in a CAD program:

Standardization: Templates can be used to ensure that all drawings in a project or 
company are uniform. You can define standards for fonts, layer structures, line types, 
units of measurement and much more.

Time saving: Instead of having to start from scratch with every new drawing, you can 
start with a template that already contains basic settings and elements. This can include, 
for example, a ready-made layout, a title block or frequently used objects.

Reduction of errors: By using a template, errors can be reduced that can occur due to 
manual input of repeated information. This leads to greater accuracy in the drawings.

Efficiency: Templates can also contain certain settings that optimize the performance of 
the CAD program. This can increase the working speed and improve efficiency.

Professional look: A well-designed template can help your drawings make a professional 
impression. This is especially important if you are sharing drawings with clients, 
contractors or other external parties.

Under File → Save as.

Let's save the file with the name

001_VORLAGE.DXF.

Every time you create a new 
drawing, you could select File -> 
New from Template → 
001_VORLAGE.DXF...

... or it is better to create a so-called standard template, as described in the following 
chapter.
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18.1 Standard template
Simply put, templates are nothing more than a simple drawing file that contains, in 
particular, various settings and components that can be used repeatedly. These settings 
can be as simple as the paper definition and unit specifications, but can also include layers, 
block devices and drawing elements like any other drawing.
However, these settings are only limited to the drawing itself. Templates cannot 
change application preferences or other global settings in LibreCAD.

LibreCAD contains a standard template, "empty.dxf", which is installed with the 
application and is located in the resource directory. It is initially used as the default 
template for all new drawings. A custom template can be used instead of the default 
template by specifying the new template in the application preferences.

In the menu, select Options → Application settings and click on the "Paths" tab. Enter 
the path and the file name (...\001_VORLAGE.DXF) of the template to be used as the 
default template. The specified template is used instead of the LibreCAD default 
template when the application is started and for new drawings:

The download link for the standard template used in the book can be found in the chapter
57.4 Standard parts, standard template and more

Tip: We recommend that you store the standard template and the standard parts library 
in a central location that can be accessed from all computers if you are working with 
several computers.
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19 Hotkeys / short keys
The Ctrl key corresponds to the Ctrl key on the German layout.

A + Enter Bow

Pos 1 / Home Sequence: Move objects to the top

Image up / PgUp Sequence: Move objects one to the top

Picture down / Pg Dn Sequence: Move objects one down

End / End Sequence: Move objects all the way to the bottom

Ctrl + A Select all

Ctrl + C Copy to clipboard

Ctrl + D Switches to or from draft mode. In draft mode, hatchings 
are invisible and only bounding boxes for images and text 
are displayed. Drawings are displayed faster, especially on 
slow computers and good for large drawings.

Ctrl + G Show or hide grid

Ctrl + I Show/hide status bar

Ctrl + K Deselect all selected

Ctrl + O Open file

Ctrl + P Print

Ctrl + R Reverse direction

Ctrl + V Paste from clipboard

Ctrl + Z Undo

Ctrl + Y Redo

Del / Del Delete selected objects

Ctrl + S Save

Ctrl + P Print

F5 Redraw

F11 Enlarge to full screen

For more information, see chapter 22 Drawing tools and command line
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20 Drop-down or floating menus?
Most LibreCAD commands are accessible via the menu bar.

Floating menus are menus that are not fixed to a specific position in the user interface, 
but float freely and can be placed anywhere on the screen. The advantage of floating 
menus is that they are flexible and can be adapted to any working environment. For 
example, they can be dragged to the edge of the screen to create more space for the 
drawing area or placed near the workspace to allow quick access to frequently used 
commands.

Drop-down menus are menus that hang down from the menu bar at the top of the 
window. They are normally called up by clicking on a menu button in the menu bar. 
Drop-down menus usually contain a wide range of commands and functions that are 
relevant for the entire application.

Drop-down menus provide access to file and print operations, application and drawing 
configurations, drawing and editing tools and other functions.

The drop-down menus can be converted into a floating 
menu.

Each drop-down menu has a dashed line at the top. If you 
click on the dashed line and drag it, you can "tear off" the 
menu and move it to another location on the screen.
postpone.

If you click on the item in the top 
right-hand corner of the floating 
menu, it will close.
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21 What are widgets?
In LibreCAD, widgets are graphical user 
interface elements that provide certain 
functions and tools of the program. These 
widgets can be displayed in the Widgets → 
Docking widgets menu and provide a quick and 
easy way to access frequently used commands 
and functions.

Widgets can be customized and configured in LibreCAD to optimize 
your workflow. You can add or remove widgets, change their size 
and position and even create custom widgets.

To add or remove a widget in LibreCAD, right-click on an empty 
space in the toolbar or in the menu and select "Docking widgets" 
from the context menu. A dialog box appears in which you can 
select the available widgets and add or remove them.

Docking widgets provide a quick and easy way to access frequently 
used commands and functions in LibreCAD. By customizing and 
configuring widgets, you can optimize your workflow and draw and 
edit more efficiently.

Info: As everyone can position their own widgets as they wish, it 
would be complicated to explain where to find the functions in the 
rest of this book. Therefore, this book refers to working WITHOUT 
widgets.
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22 Drawing tools and command line
The drawing tools are used to create and change elements such as lines, circles etc. in a 
drawing. Commands can be selected from the menu or toolbars or entered via the 
command line. Right-click anywhere in the drawing window to bring up a pop-up menu 
that displays the history of commands called from the menus or toolbars, with the most 
recent command at the top of the list. Note that the command line input is not 
displayed.

Some drawing tools require additional parameters, which are displayed in the upper 
status bar or toolbar as "Tool options". This toolbar should always be activated. If the 
tool options are not displayed, select Widgets → Toolbars → and activate Tool options. If 
you are using the command line, the same tool options are available via the toolbar or 
the command line. The tools that have options are listed in the table below.

Info: Commands in italics apply to the English version.

22.1 Line tools

Action Icon Command Remark

2 points l, li, line 
l, li, line

Draw a line between two assigned points.
Tool options:

Angle

Line from a point with an angle and a 
length.
Tool options:

Horizontal hor, horizontal

Horizontal line over center, end of line 
and length.
Tool options:
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Vertical Ver, vertical

Vertical line over center, end of line and 
length.
Tool options:

Rectangle rec, right
rect, rectangle

rectangle by assigning the points of two 
diagonally opposite corners.

Parallel through 
point Pp, ptp

A certain number of lines parallel to a 
selected existing line through an 
assigned point.
Tool options:  

Parallel o, pa, 
offset, 
parallel

A number of lines, parallel to a selected 
existing line, with a distance between the 
lines.

Angle halves de bi, bisect

A certain number of lines that bisect two 
angled lines.

Tangent (P,K) tanpc, 
tangentpc

Line from an assigned point tangential to 
an existing circle.

Tangent (K,K) Line tangent to two existing circles.

Tangent at 
right angles

Line that is tangent to an existing circle 
and perpendicular to an existing line.
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Right-angled ortho, perp

A line of a certain length that runs 
perpendicular to an existing line and 
whose center lies at a certain point.

Relative 
angle

Line with a certain length and a certain 
angle in relation to an existing line.

Polygon (center, 
corner)

poly2
pl, polyline

N-corner with a certain number of sides 
by determining the center point and the 
vertex.

Polygon 
(Cen, Tan)

N-corner with a certain number of sides 
by assigning the two points to one side.

Polygon 
(2 
corners)

poly2, 
polygon2v

N-corner with a certain number of sides 
by assigning the two points to one side.

...

22.2 Circle tools

Action Icon Command Remark

Center, Point kr, circle
ci, circle

Circle with a free radius, and 
center.
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2 points c2, circle2
Circle with a certain diameter, over you 
two opposite points on the circumference 
of the circle.

2 points, radius

Draw a circle with two points on the 
circumference and with a certain radius:

3 points c3, circle3 Circle with three points on the 
circumference.

Center 
point, radius cc, circlecr

Circle with a certain radius whose center 
is a certain point on the circumference of 
the circle.

Tangential,
2 circles, 1 point

Draw a circle that is tangent to two 
existing circles and define a center point 
to determine the radius.

Tangential, 
2 points

Circle tangential to an existing circle via 
the diameter and two points on the 
circumference.

Tangential,
2 circles, radius

Circle tangential to two existing circles 
with a certain radius.

Tangential, 
3 circles ct3, tan3 Circle tangential to three existing circles 

and/or lines.
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22.3 Arcs, ellipses and spline tools
Arcs, splines, ellipses

Action Icon Command Remark

Center, point, 
angle ci, circle

Circular arc with a radius through a center 
point and a point on the circumference, 
indicating the direction of rotation:

3 points a, ar, arc

Draw an arc by assigning three points on 
the circumference of the arc that define 
the start position, a point on the 
circumference and the end position of the 
arc.

Tangential arc

Draw an arc tangential to the end of an 
existing line segment with a defined radius 
or angle (deg).

Spline spl, spline

Draw an open or closed spline (curve) by 
assigning control points and a specific 
degree of freedom (1 - 3).

Spline 
through 
points

stp, spline2

Draw an open or closed spline (curve) by 
defining points on the spline.

Elliptical arc 
(axis)

Elliptical arc over main axis, second axis, 
start and end angles.
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Freehand line fhl, free 
fhl, free

Draw a non-geometric line.

...

22.4 Ellipse tools
Ellipses

Action Icon Command Remark

Ellipse (axis)

Draw an ellipse by assigning a center 
point, a point on the circumference of the 
main access point and a point on the 
circumference of the secondary access 
point.

Ellipse 
Focal point

Draw an ellipse by assigning two focal 
points and a point on the circumference.

Ellipse 4 point Draw an ellipse that has four points on its 
circumference.

Ellipse center 
and 3 points

Draw an ellipse by defining a center and 
three points on the circumference of the 
circle.

Ellipse within 4 
lines

ellipsis 
inscription d

Draw an ellipse that is bounded by four 
existing non-parallel line segments.

...
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22.5 Polyline tools
Polylines are contiguous elements as a block.

Action Icon Command Remark

Polyline pl, polyline

Draw an ellipse by assigning a center 
point, a point on the circumference of the 
main access point and a point on the 
circumference of the secondary access 
point.

The options include line and for curved 
segments: tangential, tan radius and 
angle.

Add node
Add a node to an existing polyline. (Use 
"Snap to element" to place the new node 
on the segment).

Attach 
node

Add one or more segments to an existing 
polyline by selecting the polyline and 
adding a new node end point.

Delete node Delete selected node of an existing 
polyline.

Delete 
between two 
nodes

Delete one or more nodes between 
selected nodes of an existing polyline.

Trim 
segments

Extend two separate, non-parallel 
segments of an existing polyline so that 
they intersect in a new node.
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Create 
equidistant 
polylines

Draw a certain number of polylines 
parallel to a selected existing polyline with 
a certain distance between the lines.

Create polyline 
from existing 
segments

Create a polyline from two or more 
existing separate line or arc segments that 
form a continuous line.

...

22.6 Catch functions, snapping options
Snap functions offer the option of selecting precise positions with the mouse. Various 
snapping tools are available with which the user can snap to different positions on 
objects or the drawing area. These functions are located in the lower status bar.

Objects Catching, snatching, snapping

Action Icon Command Remark

Exclusive 
fishing 
mode

On: Only one snapping mode is 
permitted. Off: Several catch modes 
are permitted The catch modes are 
saved in every state.

Imaginary center

Enables the "imaginary" snapping of a 
center point without an existing line. Click 
on any two points. The center point of the 
line is snapped.

Free os, sf
Allows the crosshairs to move freely 
while other capture modes are activated.
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58 Contributors

There are many people who have contributed to the LibreCAD User Guide. Some 
contributions came via the LibreCAD forum, the wiki or the source code.

Some of those who have contributed directly or indirectly are: André 

Hurler

Armin Stebich Bob Woltz 

Chris G Clive Tubb

David Huff dellus 

Dli, Fabrice

Ferdi Gary S (Maintainer)

R. van Twisk Ravas

Richard M Brown Stano Sitar

58.1 Corrections, improvements, errors found
Please contact us at the following e-mail address: cadcam@etik.com

mailto:cadcam@etik.com
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